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INTRODUCTION 
Chapter
This chapter presents the following information:

C What is WinAlign?

C General alignment concepts

C The WinAlign workflow

C Listing of additional relevant user guides
1
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WHAT IS WINALIGN?

WinAlign helps you to re-use valuable translation material from previous projects by allowing you to 
create a translation memory from your existing translations that can be imported into Translator’s 
Workbench. WinAlign examines the source and target language texts to determine which sentence 
pairs belong together and creates a file which is then imported into Translator’s Workbench. 
Alignment is the process of determining which parts of the source and target language files belong 
together and putting them side by side or aligning them. The user plays an interactive role in the 
alignment process which enhances the alignment results.

TRADOStag

WinAlign provides direct support for TRADOStag (TTX), a TRADOS specific bilingual file format. 
TRADOStag provides a standard method of describing tagged text formats for translation purposes. 
Text and formatting information are extracted from the native file format and presented in an 
abstracted file format, TRADOStag. After translation the TRADOStag file will be merged with the 
native file to create a translated document. TRADOStag files are XML compliant and consist of well 
formed XML documents that can be processed without explicit reference to DTD.

WinAlign supports the TRADOStag XML workflow for Doc files. You can control if Word files are 
converted to .ttx before processing. The default is to convert files to .rtf.

Languages Supported

WinAlign is based on UNICODE and supports all languages supported by Windows 2000 and 
Windows XP, including Asian and bi-directional languages. If you want to process Asian or 
bi-directional languages, TRADOS recommends working with a recent localized or enabled version 
of the operating system. 

Under Windows 2000, you must install the relevant language packs to support the alignment of 
bi-directional and Asian languages.
WINALIGN USER GUIDE
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ALIGNMENT CONCEPTS

This section contains brief explanations of some of WinAlign’s main features.

Structure Recognition

When linking source and target texts, WinAlign makes use of the fact that documents are usually 
structured and divided into various sections. For example, when a document is created in Microsoft 
Word, it usually contains structural elements identified by style names. The chapter title may be 
identified by the Heading 1 style. The same formatting must be preset in the translated text as in the 
source. Other text formats, such as SGML/HTML, FrameMaker, Interleaf and Ventura, use tags for 
this purpose. WinAlign uses this information to create a structure tree for the source and target 
documents, and allows you to interactively influence how this tree is built. Even when the document 
pairs do not have a clear structure, WinAlign can use font sizes and paragraph numbering to 
perform structure recognition.

Identifying Segment Pairs

Once this structure has been determined, WinAlign begins linking the individual segments. A 
segment is a sentence, title, footnote, table cell, list element, caption or any other textual unit that 
WinAlign identifies. The program examines the source and target texts carefully to create the most 
accurate segment alignments possible. Both context-related and content-related characteristics are 
taken into consideration. WinAlign analyses all features of the file, for example, index entries, 
footnotes, proper names, numbers, dates, formatting or tags. The program also provides tuning 
options to determine how much importance should be placed on these source and target text 
elements during the alignment.

The user can help optimize the alignment by supplying project-specific abbreviation and 
terminology lists. WinAlign considers a large number of factors during alignment, which helps to 
produce a high number of matching segment pairs.

The Alignment Editor

Once the first alignment run is finished, WinAlign presents you with the alignment results in the 
alignment editor, specially developed for post-processing alignments. In the alignment editor, you 
can manipulate the segment pairs suggested by WinAlign. For example, you can combine, reassign, 
delete or even change their content to correct typing mistakes. The text is displayed with all its 
formatting intact — in WYSIWYG (What You See Is What You Get) fashion, just as you are 
accustomed to seeing in your word processor. This makes it easy, for example, to visually match a 
source segment containing a bold word with its target-language equivalent.
WINALIGN USER GUIDE 1-3
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In addition to allowing you to adjust segment pairs, the alignment editor also displays the overall 
outline of the documents in a tree diagram and you can also reassign text blocks at this level. You 
can search for specific text within segments using the Edit menu in WinAlign. You can also use the 
Go To function to find specific segment types, for example, to go to all 2 to 1 alignment units (where 
two segments in the source text have been aligned with one segment in the target text). You can edit 
segments directly in the alignment editor.

Project Management

WinAlign provides several powerful project management features. At any time, you can add new 
files to your project, call up information on files, check the overall status of the alignment, make 
adjustments to the tuning options, change the structure recognition settings or customize how 
segments are displayed. You can also save your intermediate results so that larger alignment projects 
can be easily managed across multiple sessions.

After you have aligned files, you can use the File Pair Statistics command on the Alignment menu to 
generate a report that contains statistics on either selected file pair alignment or on the entire 
alignment project. 

Exporting Alignment Results 

When you are satisfied with your alignment, export the results. You have two choices of export 
format: export to Translator’s Workbench Import Format or as Translation Memory Exchange Format 
(TMX). TMX is the standard exchange format for translation memories. If you select Translator’s 
Workbench Import Format, you determine which additional information (project attributes, names 
or dates) should be generated and WinAlign then creates the import format for Translator’s 
Workbench. 

You can create a translation memory or a termbase from the WinAlign export file. You can import 
the alignment results into a translation memory in Translator’s Workbench and start re-using your 
previous translations immediately. You can also import your exported alignment results into 
MultiTerm Extract to create a termbase. For more information see the MultiTerm Extract User Guide.
WINALIGN USER GUIDE
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Alignment Workflow

The alignment workflow is summarized in the following steps:

1 Create a new alignment project in WinAlign.

2 Add source files and target files.

3 Align the source and target files.

4 Review the alignment.

5 Save the alignment project and export the alignment results.

6 Import the alignment results into a Translator’s Workbench translation memory.

RELATED DOCUMENTATION

This user guide explains how to work with WinAlign, how to create and use alignment projects, and 
how to export alignment results for use as a translation memory in Translator’s Workbench.

The following user guides contain information that is relevant to processes described in this guide:

C Translator’s Workbench User Guide – describes in detail how to work with Translator’s 
Workbench, and the Translator’s Workbench editing environments. It also outlines the 
Translator’s Workbench terminology recognition feature which allows you to access termbase 
data while translating. 

C S-Tagger User Guide – contains detailed and comprehensive information on how to manage 
FrameMaker and Interleaf files throughout the translation process. It also includes details on 
the Font Mappers for FrameMaker and Interleaf. These applications facilitate the font changes 
necessary when translating Asian language files.

C TRADOS File Formats Reference Guide – contains information about the preparation, 
conversion and post-production tasks associated with the specific file formats. This guide 
includes information about the Tag Settings Manager, and the TRADOS Story Collectors.
WINALIGN USER GUIDE 1-5
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GETTING STARTED WITH 
WINALIGN
Chapter
This chapter presents an overview of how to use WinAlign 
through the step-by-step alignment of sample files. The tutorial 
covers the following:

C Creating a new WinAlign project

C Setting up the alignment project

C Aligning the files

C Reviewing the alignment

C Editing source and target segments

C Exporting the alignment project to a text file

C Importing the alignment file into a translation memory
2
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WELCOME TO THE WINALIGN TUTORIAL

This tutorial aims to guide you through using WinAlign by demonstrating the step-by-step 
alignment of some of the sample files installed with WinAlign. The basic features of WinAlign are 
demonstrated as you align the sample files. TRADOS suggests trying these functions on your PC as 
you read through the tutorial. The tutorial presents the following steps:

C Defining the parameters of the alignment project

C Adding files to the alignment project

C Setting alignment and structure recognition options

C Saving the alignment project

C Aligning the files

C Reviewing the alignment

C Editing source and target segments

C Exporting the alignment project to a Translator’s Workbench import file

C Exporting the alignment project to a termbase

Before You Start 

A set of sample files is installed with WinAlign. If you accept the default installation path, a samples 
folder is created in C:\Program Files\TRADOS\...\Samples\WinAlign. 

If you select a custom installation, the Samples folder is created one level below the WinAlign 
program folder, for example, C:\WinAlign\Samples.

NOTE
D

This tutorial has been designed to give you an overview of the product. To keep the tutorial easy 
to follow we have not described all available options. For the purpose of the tutorial, please 
accept the default values.
WINALIGN USER GUIDE
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Starting the Program

To launch WinAlign, select WinAlign from your TRADOS Start menu. The WinAlign screen is 
displayed.

DEFINING A PROJECT 

The first step of an alignment is to define various project settings, such as the languages, the files to 
be aligned and the general alignment options, such as formatting information.

To start a new alignment project, select New Project on the File menu or click the icon on the 
WinAlign toolbar. The New WinAlign Project dialog box opens. This dialog box defines all relevant 
settings before starting the alignment. There are six tabs:

C General 

C Files 

C Alignment 

C Structure Recognition 

C Interface 

C Export 
WINALIGN USER GUIDE 2-3



Def in ing  a  Pro jec t2

2-4
General Options

The General tab allows you to:

C Assign a name to your project

C Define the source and target language and set their segmentation rules

C Set file preferences to save files for the TRADOStag XML Workflow for Doc files. This 
determines if Word files are converted to .ttx before processing. Click the checkbox to convert 
to ttx. The default is to convert files to .rtf.

C Define the type of files to be aligned. The following file types are available:

C Word Documents (*.rtf)

C Online Help Files (*.rtf)

C Word Documents (*.doc)

C HTML Files (*.htm, *.html, *.asp, *.jsp, *.aspx, *ascx, *.inc)

C SGML Files (*.sgm, *.sgml)

C XML and XLIFF Files (*.xml, *.xsl, *.xlf)

C PowerPoint (*.ppt, *.pps, *.pot)

C Excel (*.xls, *.xlt)

C Windows Binary files (*.exe, *.dll, *.ocx, *.lng)

C RC files (*.rc, *dlg)

C TRADOStag documents (*.ttx)

C A link to the Tag Settings Wizard becomes available if you are aligning tagged text files
WINALIGN USER GUIDE
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C Set an alternative path for intermediate alignment result files if desired

Alignment Example

In the first example, we will perform an English - German alignment of Word RTF files. Follow these 
steps:

1 Enter a name into the Project Name box, for example, My First Alignment Project. Note that this 
is not a file name but a label that you attach to your project. 

2 Click Source Language and select English from the list of languages.

3 Click Target Language and select German (Germany) from the list of languages.

4 Use the File Type drop-down list to specify the type of files in your own alignment 
projects. In this case, select Word Documents (*.rtf). 

NOTE
D

WinAlign remembers the file type you used when last creating a project, and displays it by 
default when you create a new project.
WINALIGN USER GUIDE 2-5
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5 Click Project Files to select where you want WinAlign to save intermediate alignment 
results. The Project Files dialog box opens.

6 For the purpose of this example, select Save Intermediate and Project Files in the Same 
Folder and click OK.

For the purpose of this example, accept the remaining default settings. In your own alignment 
projects, you can set segmentation rules to enhance WinAlign’s internal text segmentation 
algorithms for source and target documents. Set the segmentation rules by clicking the Source 
Segmentation and Target Segmentation buttons.

Intermediate Alignment Results

WinAlign keeps alignment results between sessions, which allows you to perform large alignment 
projects over a longer period of time. For this purpose, the program stores intermediate alignment 
results files in the same location as your project file each time you save the project. You can also 
choose to store these intermediate files elsewhere by clicking Project Files on the General tab and 
selecting Save Intermediate Files to Custom Location. Once you specify a custom location, WinAlign 
uses this location to store all intermediate alignment result files.

There are three intermediate results files: (*.waf), (*.waf.src), and (*.waf.trg). These files contain the 
source and target text, the segment connections and the text you modify using the Quick Edit or 
Advanced Edit features.

In the next step, we will define the source and target files for our alignment project.
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ADDING FILES TO THE PROJECT

Use the Files tab to add the source and target files for alignment to your current project.

In this example, we will align a set of two sample files from the English and German Translator's 
Workbench manual. All the WinAlign sample files were installed with the program and may be 
found in the C:\Program Files\TRADOS\...\Samples\WinAlign folder, one level above the WinAlign 
installation folder. The folder contains several subfolders with sample files in various formats. Locate 
the WordRTF folder.

NOTE
D

If you installed WinAlign into a custom directory, the Samples folder may be found one level 
below the installation folder.

Adding Source and Target Files

1 Select the Files tab. 

2 Click Add on the left side of the files tab to add the English source file. The Add Source 
Files dialog box is displayed. Browse to the location of the demo files and select 
Eng01.rtf from the list of available files. Click Open to confirm.

3 Click Add on the right side of the files tab to add the German target file. The Add 
Target Files dialog box is displayed. Browse to the location of the demo files and select 
Ger01.rtf from the list of available files. Click Open to confirm.
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4 Click Align File Names. WinAlign guesses which file pairs are to be aligned, based on 
the names of the respective files, and aligns the file names. In this case, the program 
guesses that the file name Eng01.rtf corresponds to the file name Ger01.rtf. To 
illustrate this link, WinAlign draws a line between the two files that are used during 
the alignment process.

Each source file and target file added to the Files tab is known as an alignment file pair or a file 
pair.

TIP
E

WinAlign stores the path names for source and target files between alignment sessions. You 
can keep source and target files in separate folders. WinAlign automatically opens the last used 
source/target folder each time you click Add Source Files or Add Target Files. 

You can add files to the source and target areas by directly dragging and dropping files from 
Windows Explorer into the list of source/target files.
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ALIGNMENT OPTIONS

WinAlign can take various tuning options into account to achieve optimum alignment results. For 
example, if formatting is identical across both source and target texts, it can be a useful aid to the 
alignment process. Set the tuning options in the Alignment tab. For the purpose of this example, 
follow these steps:

1 Select the Alignment tab.

2 Move the Formatting Significance slider towards the High value. The more you slide it 
towards High, the more WinAlign takes internal formatting changes inside source and 
target segments into account when assessing the reliability of a segment pair. Since 
internal formatting (for example, bold on/off or font changes) is used in the sample 
file pair, you can drag the slider further into the High half.

3 Retain the other default settings.
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STRUCTURE RECOGNITION OPTIONS

WinAlign analyses and uses the logical structure of the documents during the alignment. Typical 
examples of document structure are headings, for example, Heading 1 or Heading 2. In most cases, 
the structure of the source document is retained in the target document and is, therefore, useful for 
alignment purposes. Before aligning the individual segments, WinAlign performs a structure 
alignment based on the settings you define.

In DOC or RTF files, structure elements, such as chapter headings or subheadings, are typically 
formatted in paragraph styles built into the word processor by default. For example, in Word the 
heading styles are called Heading 1, Heading 2 and Heading 3.

WinAlign supports a structure recognition depth of four levels. This means it can align all Heading 1 
to Heading 4 parts of a document pair. Not all documents use this naming convention. Isolate the 
key styles in your documents and select these as the styles to use during the structure alignment.

To define the source and target styles in the sample files for structure recognition:

1 Click the Structure Recognition tab. 

2 Define the structure recognition depth by selecting a setting from the Structure 
Recognition Level drop-down list. Experiment with different depth values for a 
representative file pair and run test alignments until you get the desired result. In this 
example, select Level 4.
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3 Click Add under Source Styles to add structure styles from the source document. The Select 
File dialog box is displayed. Select the file to be used for structure recognition. In this case, 
there is only one source file. Double-click Eng01.rtf. This opens the Select Styles dialog.

4 Highlight styles Heading 1 to Heading 4 on the Styles in Document list and click the Add 
button. This moves the styles to the Styles to Add list. Click OK to confirm. The Structure 
Recognition tab is displayed, and the style names are now shown in the Source Styles list.

5 Repeat the same procedure for the target styles. The Source Styles and Target Styles lists now 
both contain the correct information.

6 On the Structure Recognition tab, the next step is to assign a style to a specific structure level. 
Start with the first level, which is already selected via the Level 1 radio button. To define 
Heading 1 as the first-level style, highlight this style name in the Source Styles and Target 
Styles lists.
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7 Click the Level 2 radio button and highlight Heading 2 on both lists to define this as the 
second-level style. Repeat this procedure for the remaining two structure levels, Heading 3 and 
Heading 4.

Alternative Structure Recognition Options

If your documents do not have a style-based structure, you have several alternatives to achieve quality 
alignment:

C Word’s AutoFormat Feature
Add styles to documents using Word’s AutoFormat feature. Word automatically applies 
heading and list styles by identifying large-sized heading texts and numbered/bulleted lists in 
your documents. After using AutoFormat, you can define structure recognition settings as 
described above. For more information on Word’s AutoFormat feature, consult Microsoft 
Word’s online help.

C Switch Off Structure Recognition
Switch off structure recognition in WinAlign. To do this, select Ignore in the Structure 
Recognition Level drop-down list. This generally produces better results in flat text files.

C Formatting
If your files are heavily formatted (even without styles or AutoFormat), try using Font Sizes as 
the structure recognition level option. In this case, WinAlign uses font formatting as a clue 
during structure alignment.
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SAVING THE ALIGNMENT PROJECT SETTINGS

Once you have defined a project, confirm your settings by clicking OK. The next step is to start the 
alignment process (the remaining tabs, Interface and Export, are explained later in this chapter). This 
closes the New WinAlign Project dialog box and displays the file links between all source and target 
files of your current alignment project in a new window. This window is referred to as the Project 
window.

Now save your project. Select Save Project As on the File menu. The Save Project As dialog box opens. 
Assign a file name to your project, for example, Sample, and save the file to the location of your 
choice. This saves all options that have been defined so far in the specified file. The extension PJT is 
added automatically.

NOTE
D

When you save your project, the absolute file paths are saved. If you want to move your project 
to another location you must save the project to that location. If you move it without saving it, 
the project does not open as it cannot locate the necessary files.
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PERFORMING AN ALIGNMENT

There are three ways to start an alignment:

C To align the whole project, select Align Project on the Alignment menu.

C To align an individual file pair, highlight the file pair, right-click (or press [Shift]+[F10]) and 
select Align File Pair(s) on the shortcut menu. Alternatively, select Align File Pair(s) on the 
Alignment menu.

C Double-click on the file pair to align. 

WinAlign opens a dialog box showing the alignment progress of the file pair 
Eng01.rtf—Ger01.rtf. If you align the whole project in one batch, the dialog box displays two 
progress indicators: one for the whole project and another for the current file pair. If you align an 
individual file pair only, the dialog box shows the progress for that particular file pair.

Once the alignment is done, WinAlign opens the file pair in the alignment editor.
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REVIEWING AN ALIGNMENT

Once the alignment is complete, you can examine the results and make corrections, if required, to 
misaligned structures and/or segment pairs. You review and modify the alignment in the alignment 
editor.

Highlight any file pair of your alignment project whose initial alignment is complete (indicated by 
), right-click and select Review File Pair(s) on the shortcut menu. Alternatively, select Review File 

Pair(s) on the Alignment menu. This opens the alignment editor for the current file pair.

NOTE
D

C If you have aligned several file pairs in one batch, a separate alignment editor window 
opens for each file pair. 

C Each time you save a project, WinAlign saves the current alignment connections of all 
aligned file pairs in intermediate alignment result files. These files are saved to the same 
location as your project file (PJT) by default. 
You can specify an alternative path by clicking Project Files on the General tab on the 
Project Settings dialog box and selecting Save Intermediate Files to Custom Location, and 
entering the location of your choice. Next time you open the project and review one of the 
previously aligned file pairs, WinAlign needs to reload the corresponding files before being 
able to display the results in the alignment editor. This may take a few minutes.
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The Alignment Editor

The alignment editor is divided into two areas: the outline area and the segment area.

Figure 2.1 - Alignment Editor Interface

Outline Area

The outline area consists of three frames: the source outline frame, the outline link frame and the 
target outline frame. WinAlign uses the outline area to display the structure alignment results. In 
this case, WinAlign used the styles Heading 1 through Heading 4 as the structure recognition levels 
during the structure alignment. 

As a result, the program has attempted to match the source English Heading 1 through Heading 4 
texts with their corresponding equivalents in the target German text. The result of this matching 
process is displayed in the outline link frame, where WinAlign displays the links established 
between source and target heading texts. In our sample alignment, WinAlign established links for 
all headings. This is indicated by the lines drawn between all source and target structure levels.

NOTE
D

WinAlign displays the Level 1 and 2 structures by default. If the source and target files contain 
four levels, select Level 4 from the View menu to display all four levels. 

Segment area

Outline area

Source outline Outline link Target outline
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Useful Commands in the Outline Area

C To show or hide a structure level, click the plus (+) or minus (-) signs at the left of the 
corresponding structure.

C To disconnect a link between a source and target structure, right-click one of its icons ( ) in 
the outline link frame and select Disconnect from the shortcut menu. This removes the link 

and changes the appearance of the icons to indicate that they are disconnected (  and ).

C To establish or re-establish a link between a source and target structure, left-click its icon ( ), 
keep the mouse button pressed and draw a line to the desired target structure. As soon as you 
reach the target structure icon, it changes appearance to indicate whether it is ready to be 

connected ( ) or not ( ).

C For more information on commands, press [F1] in the alignment editor.

WinAlign has aligned the source and target structure without any problems, so we are now ready to 
take a look at individual structure levels. Each of these levels consists of one or more source and 
target segments. Each segment is usually a sentence, but it can also be a heading, bullet list text or 
index entry.

To display the alignment results of a particular structure level, click the heading text of the structure 
you want to look at. In our example, click the English heading Preparing Microsoft Word. This fills 
the lower half of the alignment editor with the segment pairs. This area is referred to as the segment 
area.

Figure 2.2 - Segment Area

Outline 
area

Segment 
area

Source and Target TargetSource 

Segment Link Frame
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Segment Area

As with the outline area, the segment area consists of three frames: the source segments frame, the 
segment link frame and the target segments frame. WinAlign uses the segment area to display the 
segment alignment results. Segment pairs are also referred to as alignment units.

Useful Commands in the Segment Area

C To force align segments, that is manually connect the first segment in the source document 
with the first segment in the target document, and the second source segment with the second 
target segment and so on, select Align Structure Level>Force 1:1 Connections from the context 
sub-menu or Alignment menu. 

C To disconnect a link between a source and target segment, right-click one of the icons ( ) in 
the segment link frame and select Disconnect on the shortcut menu. This removes the link 

and changes the appearance of the icons to indicate that they are disconnected (  and ).

C To confirm a (dash-) dotted link between a source and target segment, right-click one of the 

icons ( ) in the segment link frame and select Commit on the shortcut menu. 
The (dash-) dotted line changes into an unbroken solid line, indicating that this is a 100% 
aligned unit.

C To establish a link between a source and target segment, left-click the source segment icon 

( ). Hold down the mouse button and draw a line to the target segment icon. As the line 
reaches the target segment icon, it changes appearance to indicate whether it is ready to be 

connected ( ) or not ( ).

C To disconnect all alignment units in a structure level, right-click in a free spot in the segment 
link frame and select Disconnect All Units from the context sub-menu. This removes all links 
between source and target icons, so you can create your own connections. 

C To force align segments on the structure level, select Align Structure Level>Force 1:1 
Connections from the Alignment menu. 

C To commit all alignment units in one structure level, right-click in a free spot in the segment 
link frame and select Commit All Units from the context menu.

C To commit or disconnect selected units, select the alignment units you wish to commit or 
disconnect using [Shift]+[Click], right-click in the source segments area and select Commit 
Selected Units or Disconnect Selected Units from the context sub-menus. Alternatively, you 
can select these options from the Commit or Disconnect sub-menus on the Alignment menu.
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C To disconnect all the units in the current structure level that you have not yet committed, 
select the All Non-Committed Units command from the Disconnect sub-menu on Alignment 
menu. You can also access this command by right-clicking in the source or target segment 
area in the alignment editor and selecting All Non-Committed Units from the context 
sub-menu. 

C To highlight internal, external and non-translatable tags in the source and target segments, 
select the Tag Text command from the View menu. This makes the translatable text very 
obvious and reduces the possibility of you deleting or editing tags inadvertently. You can 
choose to display partial, complete or no tags. 

NOTE
D

Changes you make to the segments are saved in the alignment project. If you align the files 
again these changes are lost. 

Confirming Segment Alignment Results

The source and target segments are all connected with dotted lines. This means that WinAlign 
assumes them to be reliable alignment units. The more reliable WinAlign assumes the units to be, 
the closer the dots are between source and target segments. The first alignment unit – the heading 
text in English and German – is a perfect match, so you may want to confirm it. 

To confirm the first alignment unit:

C Right-click the icon of the source or target segment icon  and select Commit from the 

context sub-menus.

C Alternatively, select the first alignment unit so that the English text is displayed on a black 
background and the corresponding German text is displayed on a grey background. To 
confirm the alignment unit, select Selected Units from the Commit sub-menu on the 
Alignment menu.

To confirm multiple alignment units, such as the first and second alignment units:

C Select the first and second alignment units using [Shift]+[Left-click]. The English text is 
displayed on a black background and the corresponding German text is displayed on a grey 
background. When both alignment units are selected, select Selected Units from the Commit 
sub-menu on the Alignment menu.

C Alternatively, right-click inside the source or target segment text, and select Selected Units 
from the context sub-menus.
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NOTE
D

If you have right-clicked inside the source or target segment text, you have activated the current 
alignment unit. 

After you confirm an alignment unit, the dotted line is replaced by an unbroken, or solid, line. The 
alignment unit is now committed. Committed alignment units provide further anchor points for 
WinAlign in subsequent alignments.

The first two segment pairs are now connected with unbroken lines. Both alignment units are 
selected and are displayed on a black and grey background respectively. The second alignment unit is 
the active alignment unit because it is surrounded by a dotted line. 

Confirming Several Alignments at the Same Time

You can confirm multiple alignment units at the same time by following these steps:

1 Right-click in the segment link frame. Do not click any icon; right-click a free spot. The 
segment link context sub-menu is displayed.
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2 Select Commit All Units. This changes all remaining dotted lines to unbroken, or solid, 
lines and confirms all the alignment units in the current structure level.

The alignment units are now confirmed, as illustrated below:
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Committing each alignment separately would be a tedious task. Alignment units linked by dotted 
lines are ready for further processing (such as export) without any modifications. However, 
committing alignment units provides WinAlign with more clues for further alignments.

TIP
E

Spot-check structure levels for misalignments and correct them as necessary. If nothing is 
misaligned, leave the structure level as is. However, if alignment goes wrong at some stage, it is 
useful to disconnect some alignment units, make new connections as needed and save your 
changes.

Once you have edited the structure level, work your way through all remaining outline levels of the 
source and target text. Start from the top level and work your way to the end.

Editing Segment Alignment Results

In the previous example, WinAlign’s segmentation of the German text has resulted in a 
misalignment of the third alignment unit. By default, a colon (:) ends a segment. As a result, 
WinAlign has split the second English sentence into two segments. They must be connected to one 
single German segment on the target side. Instead of linking it to the second English segment, 
WinAlign links the third and fourth English segments to the third German one.

To fix this, follow these steps:

1 Use [Shift]+[Click] to select the two English source segments containing the word 
Dokumentvorlage and the text starting This document template is copied... Select Selected 
Units from the Disconnect sub-menu on the shortcut menu. This removes the link between 
the misaligned source and target segment, and changes the appearance of the icons 

to  and .
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2 Click again the icon representing the source segment reading Dokumentvorlage and 
draw a line from it to the second icon on the target side. This establishes a link 
between the two. We have now created what is referred to as a 2:1 alignment unit, 
where two source segments are linked to one target segment.

Re-aligning the File Pair

After correcting misalignments and confirming new ones throughout the whole file pair, you can 
run a second alignment on it. This is referred to as re-alignment. During re-alignment, WinAlign 
takes into account any changes made when editing the initial alignment result. For example, 
WinAlign uses any committed alignment units as reliable anchor points.

To re-align the file pair, right click in the segment link frame and choose the Align Structure 
Level>Standard Connections command from the Project window shortcut menu. You can also select 
Align File Pair>Standard Connections on the Alignment menu in the Project window. 

Alternatively, you can align segments by force. If you know particular segments are identical, you 
can quickly align them using the Force 1:1 Connections command. This command is available on a 
segment level or structure level. These connections are not committed and require further review.
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Force Alignment

Force alignment manually connects the first segment in the source document with the first segment 
in the target document, and the second source segment with the second target segment and so on 
until the end of document is reached. These connections are considered high quality in terms of 
segment pair reliability, but are not committed and require review.

Forcing a Segment Level Alignment

You can force align on the segment level; that is align segments one at a time.

1 Choose your source segment and click Start Connecting Segments>Force 1:1 Connections on 
the Alignment menu. The target segment directly across from it is selected. 

2 Click Finish Connecting Segments>Force 1:1 Connections on the Alignment menu to 
make the connection. These connections are considered high quality, but are not 
committed and require review.

3 Review the alignment connections and commit the segments if approved. See 
Confirming Segment Alignment Results on page 2-19.

Forcing a Structure Level Alignment

You can force align on the structure level. The unaligned portions of a document can be force aligned 
all at once. Committed segments are ignored during this process. If an equal number of source and 
target segments do not exist, the remaining segments remain disconnected. For example, if your 
document has three source segments and five target segments, the last two target segments will 
remain disconnected.

1 Choose Align Structure Level>Force 1:1 Connections on the Alignment menu. 

2 Review the alignment connections and commit the segments if approved. See 
Confirming Segment Alignment Results on page 2-19.
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EDITING SEGMENT TEXT IN THE ALIGNMENT EDITOR

The Edit menu provides several features designed to facilitate editing segment text directly. You can 
divide them broadly into two areas:

C Navigating the alignment file

C Editing the alignment file

Navigating the Alignment File

After you have aligned the files and are reviewing the alignment, you can search for particular text 
in the source or target alignment units and modify it. There are four commands to help navigate an 
alignment file.

C Find 

C Find Next 

C Go To

C Go To Next

Find

The Find c0mmand searches for text in the source and target alignment segments. Use the Find 
Next to search for the next instance of your search text.

To find text, follow these steps:

1 In the current Sample alignment project, select Find on the Edit menu. The Find dialog box is 
displayed.

2 Enter the text document and click Find Next.
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3 WinAlign finds an alignment unit starting with the text In order to prepare Word for 
the communication... 

You are now ready to edit the source and or target text of the alignment unit.

NOTE
D

To search for the same text elsewhere in the alignment project, select Find Next on the Edit 
menu or press [F3] in the alignment editor.

Go To

Use the Go To command to locate segments that you want to pay special attention to during the 
alignment review. 

To use the Go To functionality, follow these steps:

1 Select Go To on the Edit menu.

2 The Go To dialog box is displayed. There are two group boxes in the Go To dialog box: 
Quality and Constraints. Accept the default settings: Any Segment under Quality and 
1:2 and 2:1 Units only under Constraints. This means that WinAlign locates any 
segment that is part of a 1:2 or 2:1 alignment unit. Click Go To. 
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3 WinAlign finds the first 1:2 alignment unit and makes it the active unit.

You are now ready to edit the source and or target text of the alignment unit.

NOTE
D

To go to the next 1:2 or 2:1 alignment unit, select Go To Next on the Edit menu or 
press [F5] in the alignment editor.

Editing Source and Target Segments

WinAlign allows you to edit source and target segments directly. This means you can insert last 
minute changes as well as ensuring that your alignment file is as accurate as possible. Editing 
options include:

C Editing segment text using Quick Edit or Advanced Edit. Advanced Edit allows you to edit tags 
as well as text.

C Cutting, copying, and pasting text between source and target segments. 

C Undoing and redoing actions within a segment.

C Joining segments. You can also choose to insert a space between joined segments.

C Splitting a segment.

C Inserting an empty segment above or below the active segment.
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Editing Segment Text Using Quick Edit

There are four ways to access Quick Edit:

C Double-click directly in the segment you want to edit.

C Select the segment you want to edit, and press F2.

C Select the segment you want to edit, and select Quick Edit from the Edit Segment sub-menu on 
the Edit menu.

C Select the segment you want to edit, right-click and select Quick Edit from the Edit Segment 
sub-menu on the context menu.

In each case, a cursor is displayed in the segment you want to edit. You are now in Quick Edit mode. 
You can move, copy, add, and delete text.

When in Quick Edit mode you can use the arrow keys to move around the segment. The up and down 
arrows jump to the first and last line in the next segment if you have already passed the first or the 
last line in the current segment.

You can also press the [F2] key to toggle Quick Edit mode on or off.

Once you have made changes to the segment, you can:

C Press the return key or the [F2] key to exit edit mode and confirm your changes.

C Press the [Esc] key to exit edit mode and discard your changes.
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NOTE
D

C Any text you add will have the same formatting as the text directly preceding it. If you press 
[Ctrl]+[Space] WinAlign removes the formatting from your text addition.

C If you are editing segments with complex RTF formatting, TRADOS recommends that you 
use Advanced Edit. Complex RTF formatting features such as index entries in Word 
documents and jumps in online help files are usually denoted by curly brackets.

Editing Segment Text Using Advanced Edit 

Use Advanced Edit if you want to edit RTF tags. There are three ways to access Advanced Edit:

C Select the segment you want to edit, and select Advanced Edit from the Edit Segment sub-
menu on the Edit menu.

C Select the segment you want to edit, right-click and select Advanced Edit from the Edit 
Segment sub-menu on the context menu.

C Select the segment you want to edit, and press [Ctrl] + [I].

WinAlign displays the text as RTF code in the Advanced Edit box.

Make your changes to the text. For example, delete the word document so that the edited text now 
reads...you must load and activate the template... Click OK.
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Cutting, Copying and Pasting Segment Text

You can cut, copy and paste text to and from source and target segments when in Quick Edit mode. 

C To cut text, highlight the text you want to cut and select Cut from the Edit menu. You can also 
use the standard [Ctrl] + [X] shortcut.

C To copy text, highlight the text you want to cut and select Copy from the Edit menu. You can 
also use the standard [Ctrl] + [C] shortcut.

C To paste text, highlight the text you want to cut and select Paste from the Edit menu. You can 
also use the standard [Ctrl] + [V] shortcut.

NOTE
D

To cut, copy, or paste text while using the Advanced Edit feature, use the shortcuts.

Undoing and Redoing Actions within a Segment

You can undo and redo editing actions when in Quick Edit mode. Undo and Redo apply to actions 
carried out in one segment only.

To undo an action, select Undo from the Edit menu. You can also use the standard [Ctrl] + [Z] 
shortcut.

To redo an action, select Redo from the Edit menu. You can also use the standard [Ctrl] + [Y] shortcut.

NOTE
D

C To undo all actions and exit Quick Edit mode, press [ESC].

C To undo or redo an action while using the Advanced Edit feature, use the shortcuts.
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Joining Segments

To join segments:

1 Press the [Ctrl] or the [Shift] key and use the mouse to select the segments you want to join.

2 Select Join Segments from the Edit menu, or right-click and select Join Segments from 
the context menu. You can also use [Ctrl] + [J] shortcut.

3 WinAlign joins the two segments you selected. 
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NOTE
D

C To insert a space between the segments you want join, make sure that you select the Insert 
Space between Joined Segments option on the Edit menu. This option is turned on by 
default. If your text is in a language that does not require a space between joined segments, 
such as Japanese you can turn this option off.

C The formatting contained in the first segment is the formatting that WinAlign applies to the 
entire segment.

Splitting a Segment

To split a segment:

1 Double-click directly in the segment you want to split, and position the cursor at the point you 
want to split the segment. Alternatively, you can select the segment you want to split, press 
[F2] to toggle to Quick Edit mode, and use the mouse or the arrow keys to position the cursor 
at the point you want to split the segment.

2 Select Split Segment from the Edit menu, or right-click and select Split Segment from 
the context menu. You can also use [Ctrl] + [L] shortcut.
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3 WinAlign divides the segment into two segments at the point where you placed the 
cursor.

Inserting an Empty Segment

You can insert an empty segment above or below the current segment. This allows you to insert new 
information. In this example, we show how to insert an empty segment before the current segment.

To insert a segment:

1 Select the segment above which you would like to insert an empty segment.
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2 Select Above Current Segment from the Insert Segment sub-menu on the Edit menu, 
or right-click and select Above Current Segment from the Insert Segment sub-menu on 
the context menu.

3 WinAlign inserts an empty segment above the current segment.

You can now add text directly to the empty segment.
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USER-DEFINED FORMATTING

You can customize the way that WinAlign displays text in both the outline area and the segment area. 
Use the Formatting group box in the Interface tab of Project Settings to customize the formatting. 
This section covers changing the formatting in the outline area and then changing the formatting in 
the segment area.

Formatting in the Outline Area

1 Select Project on the Settings menu. The Edit WinAlign Project dialog box is displayed. 

2 Select the Interface tab to view the options for segment default formatting.

3 Click the Define Outline Formatting button.

4 The User-Defined Outline Formatting dialog box is displayed. Click Source Outline. 
Select your new settings – in this case, use Arial font with 8 point font size and blue 
colour for the source segments. Click OK to confirm.
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5 Repeat the same procedure for the Target Outline – in this case, use Times New 
Roman, 8 point font size and green colour as default formatting for the target 
segments.

6 Click OK twice to confirm your settings and close the Edit WinAlign Project dialog box. 
The outline area of the alignment editor now looks like the following:

TIP
E

If your source or target documents are of Asian or bi-directional origin, it is a good idea to 
define a user formatting with a large font size to optimize the display of Asian or bi-directional 
characters in the segment area.
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Formatting in the Segment Area

By default, WinAlign uses the paragraph formatting of the source and target segments, and displays 
the segments in a WYSIWYG fashion. This means that a heading formatted in the Heading 1 style 
also appears as such in the alignment editor. In our example, in the alignment editor, click the text 
English Sample Alignment File in the source outline frame:

The heading text looks the same as in your word processor. This allows you to find your way quickly 
through structure levels and alignment units. However, in some cases you may wish to change this 
view to display more alignment units at one time and to have a better overview of structure levels.

You can change the way segments appear in the alignment editor to suit your alignment process. For 
example, to display each source segment in 8 pt/Times New Roman/blue and each target segment 
in 8 pt/Arial/red:

1 Select Project on the Settings menu. The Edit WinAlign Project dialog box is displayed. 
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2 Select the Interface tab to view the options for segment default formatting.

3 Select the User Defined Formatting in Segment Area option under Formatting. Click 
Define Segment Formatting.

4 The User-Defined Segment Formatting dialog box is displayed. Click Source Segments. 
Select your new settings of 8 pt/Times New Roman/blue for the source segments. 
Click OK to confirm.

5 Repeat the same procedure for the Target Segments. Select your new settings of 8 
pt/Arial/red as default formatting for the target segments.
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6 Click OK three times to confirm your settings and close the Edit WinAlign Project 
dialog box. Your alignment editor now looks like the following:

You can switch between paragraph and user-defined formatting by clicking the  button on 
WinAlign’s toolbar or by selecting Paragraph Formatting on the View menu. This restores the 
segment formatting to the document paragraph styles. To switch back to your user-defined settings, 
click the  button again.

TIP
E

If your source or target documents are of Asian origin, it is a good idea to define a user 
formatting with a large font size to optimize the display of Asian characters in the segment 
area.

EXPORTING THE ALIGNMENT RESULTS

Now that WinAlign has successfully performed an alignment of the two sample documents, you can 
create an export file. You can export alignment projects in two format types:

C Translator’s Workbench Import Format: This is the default setting. When exporting, 
WinAlign changes the alignment units (linked source and target segments) into translation 
units. In addition to the source and target segments, translation units usually contain more 
information, for example, who created the translation unit, project-specific information and 
when it was created. WinAlign exports this additional translation information in the form of 
Translator's Workbench compatible system, text and attribute fields.

C Translation Memory Exchange Format (TMX): TMX format is the standard exchange format 
for translation memories. The Translator’s Workbench User Guide provides more details 
about the Translator's Workbench translation units and the use of system, text and attribute 
fields.
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NOTE
D

You can use Translator’s Workbench to create a translation memory or MultiTerm Extract to 
create a termbase from your alignment results.

Setting Export Options

Exporting alignment units in Translator’s Workbench Import Format is a two-step process: 

1 Define what project information should be exported in addition to the alignment units.

2 Start the actual export.

Defining Export Information

For the purpose of this example, export the following system, text and attribute information:

C Creation User: John Smith

C Creation Date: 02/05/2001

C Text Field ID Code with the contents AL 2000/1234

C Attribute Field Client with the value Trados

C Attribute Field Domain with the value Software

These settings are defined in the Export tab of the Edit WinAlign Project dialog box. 
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1 Select Project on the Settings menu and select Export tab.

2 Before specifying project information, define which alignment connections should be 
exported using the Export Threshold slider. The following conventions are used:

3 If you set the Export Threshold to 1%, WinAlign exports every alignment unit except 
those that were disconnected or not aligned in the first place. If you set the Export 
Threshold to 100%, WinAlign only exports units that you have committed.

4 By default, WinAlign exports the project as a Translator’s Workbench import format 
(TXT) file. This format retains the formatting information. To export, without 
formatting information, select Export as Plain Text. 

5 If you choose to export as Translation Memory Exchange Format (TMX), the check box 
Export as TMX 1.4 becomes available. If this check box is ticked TMX version 1.4 is 
exported. If this checkbox is not checked but you have selected to export as Translation 
Memory Exchange Format (TMX), the export format will be TMX 1.1. You should 
verify which format you require. 

6 To specify the Creation User, click inside the Creation User box and enter John Smith. 

100% Committed alignment units (unbroken line)

80 – 99% reliable (closely dotted line)

60 – 79% probable (dotted line)

1 – 59% less probable (loosely dotted line)
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7 To include the date on which the translation unit was created, leave the Include 
Creation Date option selected.

8 To set the text and attribute fields that are added to the export file, you need to define 
them. Click the User Defined Fields button and the Text and Attribute Fields dialog box 
opens. Click inside the Text Fields box. Type ID Code and click the Add button. The 
name is added to the list of text fields and the cursor automatically moves to the Text 
Field Content box. Now type the contents, in this example, AL 2000/1234.

9 To add the Client and Trados attribute fields, click inside the Attribute Field box. For the 
first field, type Client and click Add. The name is added to the list of attribute fields and 
the Attribute Value box is activated. You can now enter Trados.

10 To specify the second attribute, type Domain inside the Attribute Field box, click Add 
and type Software as the attribute value.

FOR MORE INFORMATION
V

By default, WinAlign specifies ALIGN! as Creation User. This ensures that Translator’s 
Workbench takes into account the alignment penalty set in Translation Memory Options in 
Translator’s Workbench. For additional information, see the Translator’s Workbench User 
Guide.

If required, you can select Export as Table as the export option. WinAlign creates a semi-colon 
delimited text file that you can import into Microsoft Excel.
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Starting the Export

To export the results of one or more file pair alignments, follow these steps:

1 Export the whole project at the same time or export the separate file pairs individually. This 
allows you to spread alignment results of different file pairs over separate export files.

C To start exporting the whole project, select Export Project on the File menu. The Export 
Project to File dialog box opens.

C To start exporting an individual file pair or a number of file pairs, select the file pair(s), 
right-click (or press [Shift]+[F10]) and select Export on the shortcut menu. Alternatively, 
you can select Export File Pair on the File menu. 

2 The Export File Pair(s) to File dialog box opens. Assign a name and location for the 
export file, for example, Result.txt.

The following is an example of the translation units in the exported text:

<TrU>

<CrU>John Smith

<CrD>02052001

<Att L=Client>Trados

<Att L=Domain>Software

<Txt L=ID Code>AL 2000/1234

<Seg L=EN_GB>English Sample Alignment File

<Seg L=DE_DE>Deutsche Alignment-Beispieldatei

</TrU>
WINALIGN USER GUIDE 2-43



Expor t ing  the  A l ignment  Resu l ts2

2-44
This exported file complies with the import format of Translator’s Workbench (Translator's 
Workbench (*.txt)). The following table explains the structure of the translation units.

FOR MORE INFORMATION
V

Refer to the Translator’s Workbench User Guide for more details on translation units.

Tag name Description

<TrU>, </TrU> Start/end of a translation unit.

<CrD> Specifies the creation date of this translation unit in the 
format DDMMYYYY.

<CrU> Specifies the creation user or ID that created the translation 
unit. By default Align! is assigned as the user ID. This 
ensures that Translator's Workbench takes into account the 
alignment penalty set in Translation Memory Options in 
Translator’s Workbench. For more information, refer to the 
Translator’s Workbench User Guide. In this case, John Smith 
has been selected as the Creation User.

<Att L=Attribute Label> Specifies the label of one of the translation unit’s project 
attributes, in this case, Client and Domain.

<Txt L=Text Field Label> Specifies one of the translation unit’s text field labels, in this 
case, ID Code.

<Seg L= Segment Language Label> Contains the language label of the segment that follows. In 
the above example, EN_GB stands for English and DE_DE 
stands for German. Lines starting with a <Seg L> tag 
contain the actual sentences and their target-language 
equivalents. For a complete list of language labels, see the 
Translator’s Workbench User Guide.
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Importing the Alignment File into a Translation Memory

Now that WinAlign has successfully carried out an alignment of the two texts and exported the 
results to a text file, you can directly import the file into a translation memory. To import an exported 
file into Translator’s Workbench:

1 Start Translator’s Workbench.

2 Select New on the Translator’s Workbench File menu. The Create Translation Memory 
dialog box opens. Select the source language, target language and system fields. Click 
Create to assign a file name to the translation memory, for example, 
English_German.tmw. Click Save to confirm.
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3 Select Import on the File menu. The Import dialog box opens. Accept the default 
settings by clicking OK.

The Open Import File dialog box opens. Locate the WinAlign export file and double-click the 
file name Result.txt to start the import.

NOTE
D

It is not necessary to define text and attribute fields (such as ID Code, Client and Domain as 
described in Setting Export Options on page 2-40) in the Translation Memory setup before 
import. Translator’s Workbench adds these fields automatically if you accept the default Import 
setting, Add to Setup. 

Please see the MultiTerm Extract User Guide for more details on MultiTerm Extract and how to 
create a termbase from your WinAlign export file. 
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END OF TUTORIAL

In this chapter, you have learned how to:

C Align Word RTF documents using WinAlign: on a file name, structure and segment 
alignment level

C Optimize the alignment process

C Perform basic tasks in the interactive alignment editor

C Create an export file, ready for use with Translator's Workbench or MultiTerm

You can now translate your document with Translator’s Workbench and avail of your previous 
translation, stored in a translation memory. For more information on how WinAlign handles 
different file formats, see Chapter 3.

KEYBOARD SHORTCUTS

Menu Command Shortcut

File New Project [Ctrl] + [N]

Open Project [Ctrl] + [O]

Save Project [Ctrl] + [S]

Edit Find [Ctrl] + [F]

Find Next F3

Go To [Ctrl] + [G]

Go To Next F5

Undo [Ctrl] + [Z]

Redo [Ctrl] + [Y]

Cut [Ctrl] + [X]

Copy [Ctrl] + [C]

Paste [Ctrl] + [V]

Edit Segment ->Quick Edit F2

Edit Segment ->Advanced Edit [Ctrl] + [I]
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Edit (continued) Join Segments [Ctrl] + [J]

Split Segment [Ctrl] + [L]

Insert Segment -> Above 
Current Segment

[Ctrl] + [B]

Insert Segment -> Below 
Current Segment

[Ctrl] + [W]

Alignment Start Connecting Segments>
Standard Connections

[Ctrl] + [Enter]

Start Connecting Segments> 
Force 1:1 Connections

[ALT] + [Enter]

Finish Connecting Segments>
Standard Connections

[Ctrl] + [Shift] + [Enter]

Finish Connecting 
Segments>Force 1:1 
Connections

[ALT] + [Shift] + [Enter]

Disconnect -> Selected Units [Ctrl] + [D]

Disconnect -> All Non-
Committed Units

[Ctrl] + [E]

Disconnect -> All Units [Ctrl] + [Shift] + [D]

Commit -> Selected Units [Ctrl] + [M]

Commit -> All Units [Ctrl] + [Shift] + [M]

Commit -> Up to Active Unit [Ctrl] + [U]

Window Source Outline Frame [Ctrl] + [1]

Target Outline Frame [Ctrl] + [2]

Source Segments Frame [Ctrl] + [3]

Target Segments Frame [Ctrl] + [4]

Menu Command Shortcut
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FILE FORMATS AND 
ALIGNMENT WORKFLOW
Chapter
This chapter presents the alignment workflow for all file types 
supported by WinAlign:

C Word documents: RTF and DOC

C RTF online help files

C HTML documents

C SGML/XML/XLIFF documents

C STF files

C TRADOStag (TTX) files 

C RC files

C Windows Binary files

C PowerPoint files

C Excel files
 3
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OVERVIEW

WinAlign supports the alignment of two categories of files: 

C WYSIWYG: The formats in this category are Word DOC/RTF, online help RTF, HTML, 
SGML and XML files, Excel and Powerpoint files. WinAlign’s alignment editor displays all 
these formats in the same way as in their original environment so that, for example, a bold 
word in HTML is also displayed bold in the alignment editor.

C Non-WYSIWYG: These are tagged text formats. For example, PageMaker text files are 
converted to TRADOStag (TTX) and then aligned. The tags represent information on fonts, 
character styles, formatting and the position of text.

This chapter contains detailed information on aligning Word, RTF help, STF, HTML, SGML/XML, 
TTX and the Workbench RTF tagged text formats. Tips are given on what to include and exclude in 
your files.

NOTE
D

Workbench RTF is supported by TRADOS, but where possible the TRADOStag format should 
be used for DTP files. 

Tagged Text Formats

The following section discusses how to prepare Ventura, PageMaker, QuarkXPress, FrameMaker, 
InDesign, and Interleaf files for alignment.

C From within Ventura, save the file as tagged text.

C Use the Story Collectors to export text from PageMaker, QuarkXPress and InDesign in a 
tagged text format. Open the files in TagEditor and save as TTX.

C Use the S-Taggers to convert FrameMaker and Interleaf files to TRADOStag (TTX). 

NOTE
D

Information on file preparation and file setup is given by way of recommendation only. 
You may find that some recommendations do not apply to your file setup.

TIP
E

To highlight internal, external and non-translatable tags in the source and target segments, 
select the Tag Text command from the View menu. This makes the translatable text very 
obvious and reduces the possibility of you deleting or editing tags inadvertently. You can 
choose to display partial, complete or no tags.
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To prepare InDesign files for alignment:

1 Export your InDesign files to ISC format using TRADOS Story Collector for InDesign. For 
more information on this application, see the TRADOS File Formats Reference Guide.

2 Convert the ISC files you created with Story Collector for InDesign to TRADOStag 
(TTX) format by opening the ISC files using TagEditor and save them as TTX files. 

You can then align the files using WinAlign.

To prepare PageMaker files for alignment:

1 Export your PageMaker files to TXT format using TRADOS Story Collector for PageMaker. 
For more information on this application, see the TRADOS File Formats Reference Guide.

2 Convert the TXT files you created with Story Collector for PageMaker to TRADOStag 
(TTX) format by opening the TXT files using TagEditor and save them as TTX files. 

You can then align the files using WinAlign.

To prepare QuarkXpress files for alignment:

1 Export your QuarkXpress files to QSC format using TRADOS Story Collector for 
QuarkXpress. For more information on this application, see the TRADOS File Formats 
Reference Guide.

2 Convert the QSC files you created with Story Collector for QuarkXpress to 
TRADOStag (TTX) format by opening the QSC files using TagEditor and save them as 
TTX files. 

You can then align the files using WinAlign.
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MICROSOFT WORD FILES

For a detailed explanation of the alignment process, refer to chapter 2, Getting Started with 
WinAlign.

NOTE
D

You may decide to align your Word files using the TRADOStag XML Workflow for Word .doc 
files. See also TRADOStag Files on page 3-31 for instructions. For information on the 
differences in the workflows see the TRADOS File Formats Reference Guide.

File Preparation

The following file preparation instructions are recommendations only. You may find that some of 
the preparation work is not needed in your particular alignment project.

In the alignment preparation phase, one part of the preparation work can be done on representative 
files, while other tasks might need to be performed on all files. Pick a representative source and 
target file pair from your alignment file pairs and check the following features:

C Identify paragraph styles that can be used for WinAlign’s structure recognition (for example, 
Heading 1 and Heading 2). If no styles are used, try Word’s AutoFormat feature to apply styles 
automatically to the document(s). For more information, see also Structure Recognition 
Options on page 2-10 and Microsoft Word’s online help.

C Accept all revisions (if any) in the files.

C Re-sort sorted lists so that the translated files match the sequence of the source files.

After you have performed these steps on the representative files, repeat the same preparation tasks 
on all files where applicable.

Alignment Strategy

When creating a new WinAlign project of Word files, define your general settings in the General tab 
of the New WinAlign Project dialog box as follows:

1 Choose Word Documents from the File Type drop-down list in the General tab of the New 
WinAlign Project dialog box.

2 In the Alignment tab, define the weighting of the various tuning options according to 
the specific document features of your alignment pairs, for example, formatting or 
numbers. If you have a term list, add it by checking the Use Term List option. Click 
Term List and browse to select your tab-delimited text file containing your term list.
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3 In the Structure Recognition tab, set the structure recognition depth and add the styles 
you have identified.

4 Run the first alignment of a representative file pair and spot-check the result. If 
necessary, change the Alignment and Structure Recognition options to suit your 
alignment pairs. Repeat this procedure on the representative file pair until you are 
satisfied with the initial alignment result. For example, it may be better to set the 
structure recognition depth to Level 2 instead of Level 4 even if your documents have 
four heading levels.

5 After adjusting the Alignment and Structure Recognition options to your satisfaction, 
you are ready to run the alignment of the whole project. After the alignment, check, 
edit and run re-alignments as necessary. Once you are satisfied with the project 
alignment, export the results.

ONLINE HELP FILES

Much of the preparation for Word files also applies to online help RTF files. The following sections 
outline RTF-specific features.

File Preparation

Follow the same preparation as for the previously discussed Word documents. You might also want 
to check the formatting and use of footnotes and hypertext links in your online help files. WinAlign 
supports help files created in Word 2000 Word 2002, and Word 2003.

WinAlign aligns all footnotes containing translatable text: Title ($) and Keyword (K) footnotes. In the 
alignment editor, these footnotes are shown within {FN} brackets to facilitate alignment review.

For help files created in earlier versions of Word, TRADOS recommends that you open them in 
Word 2000 or higher, and save them in that format prior to aligning them.

NOTE
D

Separate keyword footnotes do not affect the functionality of the help files if they are joined 
again at the final stage. You might, therefore, want to split them before alignment and re-join 
them after translation with Translator’s Workbench.
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Jumps and Popups

WinAlign recognizes jump and popup links in online help files and uses them as clues during the 
alignment process. For example, it considers an alignment unit as more probable if both segments 
contain the same hidden text in a jump link.

If your online help files include paragraph styles containing the property Double Underline, where 
there is also hidden text in the paragraph, you may want to change this throughout all files in your 
project. This makes it more difficult to recognize the context ID as a jump or popup link during 
alignment. The context ID should be formatted as hidden only.

The following example shows an online help file pair in the alignment editor. This file pair is 
included in your WinAlign samples in the Samples\WinAlign\HelpRTF subfolder for demonstration 
purposes. It features jumps, popups and footnotes.

Alignment Strategy

When creating a new WinAlign project of online help files, define your general settings in the 
General tab of the New WinAlign Project dialog box as follows:

C In the General tab of the New WinAlign Project dialog box, select Online Help Files on the File 
Type drop-down list. 

C In the Alignment tab, define the weighting of the various tuning options according to your 
alignment pairs.

C Set the structure recognition depth in the Structure Recognition tab and add the styles you 
have identified.
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NOTE
D

Since manual page breaks always start a new topic in online help files, WinAlign considers them 
as structure elements. As a result, it always assigns the title text following the page break to 
structure Level 1. The style you define for structure Level 1 is treated as a Level 2 element, your 
Level 2 style is treated as a Level 3 element, and so on.

For example, your online help files contain the styles Heading 1, Heading 2 and Heading 3. In this case, 
you can assign style Heading 2 to Level 1 as shown below:

Follow the same process with Heading 3. The result is displayed in the outline area as follows:

NOTE
D

In many cases, it is not necessary to define structure recognition settings at all. For example, if 
the pages in your online help files are very short, WinAlign’s automatic structure recognition via 
page breaks may be sufficient.
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Figure 3.1 - Alignment Strategy for Word and Help Files

Alignment Strategy and Workflow for Word and Windows Help Files
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HTML FILES

WinAlign provides direct support for HTML alignment, including any HTML derivatives such as 
Active Server Pages (ASP), Active Server.NET (ASPX and ASPC), Java Server Pages (JSP) and 
Include files (INC). Tags are presented in the same way as they are shown in WinAlign.

File Preparation

In general, no major file preparation is required. Check the files for alphabetically sorted lists. If they 
are present, re-sort the lists so that the target files match the sequence of the source files.

NOTE
D

C WinAlign uses an independent algorithm that enables structure recognition based on 
standard tags(<h1>,<h2> etc.).

C To edit an INI file for a HTML document, specify the file as an XML or SGML file, in the File 
Type drop down box on the Project Settings General tab. This enables the Tag Settings 
button which you can use to access the Tag Settings Manager dialog box. For details on 
editing the INI file press F1 to access the online help.

Adding HTML files for Alignment

If your HTML files are spread over several subfolders, use Windows Find Files in conjunction with 
the Drag and Drop support in WinAlign. To add your source and target files to the alignment project: 

1 Select the Project command on the Settings menu to open the Edit WinAlign Project dialog 
box. Click the Files tab.
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2 Select the Search submenu on the Windows Start menu and select For Files or Folders. 
In the Search for Files or Folders named: box type *.htm; *.html. Use the Look in: 
field or locate the root folder of your source HTML files. Click Search Now. Windows 
searches all folders containing HTML files and lists them in the lower part of the 
Search Files dialog box.

3 Drag and drop all desired files from the Search Files dialog box into the WinAlign 
source or target file list as required.
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Alignment Strategy

When creating a new WinAlign project of HTML files, define your general settings in the General 
tab of the New WinAlign Project dialog box as follows:

C Choose HTML Files from the File Type drop-down list in the General tab of the New WinAlign 
Project dialog box.

C In the Alignment tab, define the weighting of the various tuning options according to the 
specific document features of your alignment pairs. 

C In the Structure Recognition tab, you need only set the structure recognition depth. WinAlign 
automatically identifies and assigns the HTML heading tags (for example,
<H1> and <H2>) to the structure recognition Levels 1 – 4. This is why the levels are 
de-activated when HTML has been chosen as a file type.

Run the first alignment of a representative file pair and spot-check the result. If necessary, change 
the Alignment and Structure Recognition options to suit your alignment pairs. Repeat this procedure 
on the representative file pair until you are satisfied with the initial alignment result. For example, 
it may be better to set the structure recognition depth to Level 2 instead of Level 4 even if your HTML 
documents have four heading levels.

After adjusting the Alignment and Structure Recognition options, run the alignment of the whole 
project. After the alignment, check, edit and run re-alignments as necessary. Once you are satisfied 
with the project alignment, export the results.
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SGML AND XML DOCUMENTS

File Preparation

Some preparation is required before you can align SGML, XML and XLIFF documents. For example, 
you must specify the document type definition (DTD) on which the SGML, XML, XLIFF documents 
are based and instruct WinAlign on how to handle SGML or XML elements, such as tags and 
character entities.

What is a Tag Settings File?

A tag settings file contains information that is necessary for processing documents that conform to 
a particular document type definition (DTD). 

The structure of an XML or SGML document is usually stored in an ASCII file, separate from the 
text of the document. The DTD defines the structure, elements and conventions to which a 
document must conform. The DTD serves as the rule book for creating an XML or SGML document. 
An example of a DTD is the HTML 4.0 DTD on which all HTML 4.0 documents are based. Many 
standard DTDs have already been designed, such as the book, article and serial DTDs included in 
ISO 12083. You can also develop your own DTD.

TRADOS supports working with both DTD-based and schema-based XML files. A schema 
essentially represents the structure of the XML file. For both types of XML files you need to use the 
Tag Settings Wizard to set up a tag settings file, so that WinAlign can distinguish between, for 
example, structural and inline elements. 

Tag settings files are also known as initialization files, and have the extension *.ini. 

TRADOS requires a tag settings file to process and format HTML, SGML or XML documents for 
translation purposes. For example, WinAlign uses the tag settings file to scan the document for 
translation and define whether tags are external (structural tags) or internal (formatting or other 
inline tags). The tag settings file also instructs WinAlign on how to handle HTML, SGML or XML 
elements, such as tags and character entities. 

Use the Tag Settings Manger to manage the tag settings files on your system. Use the Tag Settings 
Wizard to create new or edit existing tag settings files. You can access both the Tag Settings Manager 
and the Tag Settings Wizard from WinAlign.
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Managing Tag Settings

Use the Tag Settings Manager dialog box to manage the tag settings files that are available on your 
computer. 

When you select SGML or XML documents as the file type in the General tab of the New WinAlign 
Project dialog box, the Tag Settings button becomes active. 

Click Tag Settings and the Tag Settings Manager dialog box is displayed.

Use the Tag Settings Manager dialog box to perform the following tasks:

C Select the correct tag settings file from the available list. This file is used when processing the 
files during alignment.

C Open an existing tag settings file and add it to the list.

C Add new tag settings files to the list. New tag settings files are created using the Tag Settings 
Wizard, as outlined in the following tutorial.

C Remove existing tag settings files from the list.

C Change the properties of existing tag settings files (for example, the default HTML settings file 
that ships with TRADOS software). Refer to Editing Tag Settings on page 3-23 for additional 
information.
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Predefined Tag Settings Files

TRADOS ships with a series of built-in files that contain predefined tag settings for certain 
document types. These files are as follows:

C HTML4.ini – suitable for processing all HTML/ASP documents that are based on the 
HTML 4.0 DTD and have the root element HTML. 

C XSL.ini – suitable for processing XSL documents that have the root element xsl:stylesheet. 
XSL is a particular type of XML.

C RESX.ini – suitable for processing .NET RESX files that have the root element RESX. 

C XLIFF.ini - suitable for processing XML Localization Interchange File Format files that have 
the root element XLIFF.

C DITA.ini - suitable for processing Darwin Information Typing Architecture XML files that 
have the root element DITA.

Built-in tag settings files are stored in the Workbench installation folder (by default 
C:\Program Files\TRADOS\xxx\TT\..., where xxx corresponds to the name of the TRADOS software 
you are using). You can create copies of and modify these files as required.

NOTE
D

The Tag Settings Manager is shared by Translator’s Workbench, TagEditor and WinAlign. 
The changes that you make to the Tag Settings Manager list from WinAlign will affect the list as 
viewed from the other applications.

FOR MORE INFORMATION
V

For more information about the Tag Settings Manager, see the online help.
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Tag Settings Wizard

This tutorial shows you how to use the Tag Settings Wizard to add a new DTD and define settings for 
it. For the purpose of this tutorial, TRADOS uses a tag settings file that defines rules for writing 
letters in SGML. The set of representative SGML files we will align are English and German. These 
files may be found in the SGML subfolder of the WinAlign samples folder. Try out the functions as 
you read this section.

To access the Tag Settings Manager:

1 Create a new alignment project by selecting New on the File menu in WinAlign. In the 
General tab of the New WinAlign Project dialog box, assign a name to the project and select 
SGML files from the File Type drop-down list. 

2 Click the Tag Settings button and the Tag Settings Manager dialog box is displayed.
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To create a new tag settings file:

3 Click New and the Tag Settings Wizard dialog box is displayed.

4 Use the Tag Settings Wizard to perform one of the following tasks:

C Create new tag settings using the Tag Settings Wizard.

C Create a new file for default HTML 4.0 tag settings.

C Create a new file for default XSL tag settings.
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5 Read the introductory text, which summarizes the steps to be taken. Click Next. This 
opens the Tag Settings Wizard - Step 1 of 5 dialog box.

6 Specify the general tag settings, as follows:

C Provide a descriptive name for the tag settings you are going to define, for example, project. 
This is not a file name.

C Specify the type of files for which you want to create a new tag settings file. In our 
example, New Settings for SGML/HTML. 
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7 Click Next. This opens the Tag Settings Wizard - Step 2 of 5 dialog box.

8 You can import tags from *.dtd, *.ini, *.xml or *.xsd files. In our example we import 
tags from an existing SGMLsample.ini file. 

9 Review the list of suggested tags and click OK. Select the appropriate root element (in 
our example, DOCUMENT). Note that in order for WinAlign to identify the name(s) of 
the root element(s), you must first specify the DTD associated with the file.
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10 Click Next. The Tag Settings Wizard - Step 3 of 5 allows you to specify how plain text 
should be displayed in the alignment editor. The default is Arial, 10 point, no effects, 
black color. Accept the default settings.

11 Click Next to proceed to the Tag Settings Wizard - Step 4 of 5 dialog box.

This is the key step in the Tag Settings Wizard. It enables you to perform one or more of the 
following tasks:

C Define the Root Element.

C Classify the tags contained in the currently used tag settings file as external, internal or 
non-translatable.

C Define translatable attributes within tags.
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C Assign special formatting properties to text between specific tags (for example, headings 
or emphasized text).

C Add or remove tags from the list of elements.

FOR MORE INFORMATION
V

There are a number of changes you can make to the tags, using the Advanced button, which are 
part of this step. For more details click Help or press F1 to display the online help. 

12 The Emphasis tag is displayed in the tag list and is a typical example of a tag for which 
you can define formatting. For example you can assign bold formatting to any text that 
is displayed between Emphasis tags, as follows:

C Select the Emphasis tag and click Properties. This opens the Element Properties dialog box.
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C Click the Formatting tab.

C Select Bold and click OK to confirm. 

C You return to the Step 3 dialog box where the new text formatting is displayed in the 
preview box. Repeat this procedure for each tag whose formatting properties you wish to 
change.
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13 After customizing the properties of each SGML element, click Next to proceed to the 
Tag Settings Wizard - Step 5 of 5 dialog box.

14 Step 5 allows you to specify which SGML/HTML/XML character entities should be 
converted to real characters and which should be left untouched. When you select a 
public entity set from the Entity sets list, the corresponding list of entities is displayed 
in the Character entities box. By default, WinAlign converts all entities from the XML 
selected public entity set to real characters. Unconverted entities are formatted as 
internal tags, using the SGML markup with the ampersand and semi-colon delimiters. 

For example, the entity “&gt;” (> ‘greater than’ symbol) is displayed as  in WinAlign. The 
default setting ensures that all character entities are handled properly by WinAlign, so it is 
recommended that you do not make major changes to them. Any entities that have Windows 
character equivalents are converted; all others are left as they are and treated as internal tags. If 
you want to change the default settings, be careful. Generally, this should only be done by 
SGML/HTML experts. 

15 When you are satisfied with your tag settings, click Finish in the Tag Settings Wizard - 
Step 5 of 5 dialog box. You are returned to the Tag Settings Manager dialog box, where 
the new tag settings file is now listed and highlighted. You can add further tag settings 
files to this list or edit existing settings files as required.

16 Click Select to confirm that the currently highlighted tag settings file is the one you 
want to use for your project, and return to the main WinAlign window. 

You are now ready to add the SGML files for alignment.
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Editing Tag Settings

To modify existing tag settings, select a file from the list of settings files and click Properties in the 
Tag Settings Manager dialog box. The Tag Settings Properties dialog box is displayed.

Click OK to confirm that you want to modify the selected file. Each tab corresponds to one of the steps 
(1-5) in the Tag Settings Wizard. 

Alignment Strategy

When creating a new WinAlign project of SGML files, define your general settings in the General 
tab of the New WinAlign Project dialog box as follows:

C Select SGML Files from the File Type drop-down list in the General tab of the New WinAlign 
Project dialog box. Click Tag Settings to select the DTD for the files you wish to align. 
Alternatively, use the Tag Settings Wizard to set up the DTD for the files for alignment.

C In the Alignment tab, define the weighting of the various tuning options according to the 
specific document features of your alignment pairs. 

C In the Structure Recognition tab, you need only set the structure recognition depth. WinAlign 
automatically identifies and assigns the SGML heading tags (for example, 
<H1> and <H2>) to the structure recognition Levels 1 – 4. This is why the levels are 
de-activated when SGML has been chosen as a file type.

Run the first alignment of a representative file pair and spot-check the result. If necessary, change 
the Alignment and Structure Recognition options to suit your alignment pairs. Repeat this procedure 
on the representative file pair until you are satisfied with the initial alignment result. For example, 
it may be better to set the structure recognition depth to Level 2 instead of Level 4 even if your SGML 
documents have four heading levels.
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After adjusting the Alignment and Structure Recognition options, run the alignment of the whole 
project. After the alignment, check, edit and run re-alignments as necessary. Once you are satisfied 
with the project alignment, export the results.

STF FILES

WinAlign treats STF tags as either internal or external tags, with the styles tw4winInternal or 
tw4winExternal respectively. The external tags are ignored during alignment, but they can be useful 
during the alignment preparation process for structure recognition purposes. They do not appear in 
WinAlign’s alignment editor nor in the exported text file for use as a translation memory. The 
internal tags are displayed exactly as they are shown in WinAlign.

FOR MORE INFORMATION
V

For more information on generating STF files refer to the S-Tagger User Guide. When converting 
Japanese source files, it is recommended that you select "Japanese(WinAlign)" as a source 
language. Please refer to the S-Tagger User Guide for more details.

File Setup and Preparation for FrameMaker Files

Use the following as a checklist only. 

To prepare FrameMaker files for alignment:

C Turn off all change bars.

C Delete all cosmetic hard returns.

C For alignment purposes, it is not necessary to ensure that art files containing text, or which 
have callout text, are contained within anchored frames. However, expect to get warning 
messages when converting from MIF to STF if you have not ensured that they are contained 
within anchored frames. You can ignore these warning messages.

C Set to “Show” any conditional text styles (or formats) which should be included in the 
alignment and translation memory.

C Check the files for alphabetically sorted lists. If they are present, re-sort the lists so that the 
target files match the sequence of the source files.

C Update cross-references.

FOR MORE INFORMATION
V

For more detailed information, see the S-Tagger User Guide.
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Converting MIF to STF

1 Save the files as MIF.

2 Convert the files to STF using S-Tagger for FrameMaker.

You are now ready to begin the alignment of the STF files.

NOTE
D

Alternatively, you may convert MIF files to TRADOStag using S-Tagger for FrameMaker. You 
can then continue the alignment process as per the TRADOStag alignment process outlined 
later in this chapter. For more information on converting to TRADOStag, refer to the S-Tagger 
User Guide.

File Setup and Preparation for Interleaf Files

Please use the following as a checklist only.

To prepare Interleaf files for alignment:

C Open each Interleaf file. Make sure that the correct fonts are installed on your system and that 
they are recognized by Interleaf.

C Ensure that any relevant control expressions are set.

C Turn off revision tracking and ensure that there are no revision markers in the files.

C Check for “NO TAG” references and update each one.

C Check that all graphics and art files are contained within anchored frames.

C Ensure that all anchored frames which contain either micro documents, text strings or chart 
labels are positioned at either the beginning or the end of a paragraph of text.

C Turn off automatic hyphenation.

C Look at each text string in the document. If a sentence is broken into two or more text strings, 
consider replacing them with a single micro document.

C Delete all cosmetic hard returns which have been inserted purely to improve the appearance of 
the text.

C Re-sort alphabetically sorted lists so that the target files match the source files.

FOR MORE INFORMATION
V

For more detailed information, see the S-Tagger User Guide. 
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Converting Interleaf ASCII (IASCII) to STF

1 Save the files as IASCII.

2 Open each IASCII file again in Interleaf and verify that no errors are reported in the 
Opening/Saving Messages window.

3 Convert the IASCII files to STF using S-Tagger for Interleaf.

You are now ready to commence alignment of the STF files.

NOTE
D

Alternatively, you may convert IASCII files to TRADOStag using S-Tagger for Interleaf. You can 
then continue the alignment process as per the TRADOStag alignment process outlined later in 
this chapter. For more information on converting to TRADOStag, refer to the S-Tagger User 
Guide.

Enabling Structure Recognition for STF Files

In contrast to the file types described previously (Word, online help, HTML and SGML), STF files 
do not contain styles such as Heading 1 or <H1> that can be used for structure recognition in 
WinAlign. As a result, WinAlign's structure recognition feature cannot be used on STF files.

However, in almost all cases, STF files contain external tags that do carry structure information 
in the form of paragraph style tags (“<ps...>”). In the following example, the two tags 
<ps "Head 1" 1> and <ps "Head 2" 4> are placeholders for two heading levels in the 
original FrameMaker or Interleaf file:

<ps "Head 1" 1>TRADOS<:fc 1>®<:/fc> Translator's Workbench for Windows

<ps "Body" 3>the tool for <:cs "Emphasis" 1>professional translators<:/cs> who expect 
that intelligent, innovative technology offered in an ergonomic environment will bring both greater success 
and enjoyment to their work

<ps "Head 2" 4>The Translator's Second Memory

Using a Macro to Apply Word Heading Styles

Using a macro, you can apply the built-in Word heading styles to paragraphs in the STF file. You can 
find an example of this macro in the document template WinAlign.dot that was copied to the 
WinAlign program folder during installation. You can open this document template in Word. The 
macro is called WinAlignPrepareSTF. You can change it to fit your STF files.
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You need to adapt the different heading levels as created by the FrameMaker or Interleaf author. For 
example, the heading one from our example above might be <ps "Head 1">, but it could also be 
<ps "Überschrift 1">.

The sample macro WinAlignPrepareSTF applies the Word style Heading 1 to all paragraphs 
containing the external tag <ps "Head 1">. The style Heading 2 is applied to all paragraphs with 
the external tag <ps "Head 2">, and so on. To adapt the macro to your STF files, change all lines 
containing the following code:

EditReplace.Find = "ps " + Chr$(34) + "Head 1" + Chr$(34), .Replace = 

"", .Direction = 0, .MatchCase = 0, .WholeWord = 0, .PatternMatch = 0, 

.SoundsLike = 0, .ReplaceAll, .Format = 1, .Wrap = 1, .FindAllWordForms 

= 0

Only change the text that corresponds to "Head 1". Replace it with the paragraph style name(s) 
used in your STF files for heading levels. To identify the style names, open a representative STF file 
and look for some tags starting with <ps...>. You will find tags that can be used to apply Word 
heading styles as described. After you have edited the macro according to your requirements, run it 
on all STF files that you want to align.

NOTE
D

The sample macro WinAlignPrepareSTF works only in the English version of Word. This is 
because the built-in Word heading styles are localized in other language versions of Word. If 
you are using a non-English version, you must change the four lines where the style names are 
assigned to string variables. See the REM lines in the macro for details.

Manually Applying Word Heading Styles

If you do not want to edit the macro but would still like to enable structure recognition by applying 
Word heading styles, you can use Word’s Replace command. Follow these steps:

1 Open the STF file(s) in Word, if you have not already done so. Look for <ps...> tags that 
might be candidates for applying the Heading 1 through Heading 4 styles. Write the tag names 
down.

2 Create Word’s heading styles in the STF file so that you can apply them later on. Select 
Style on the Format menu in Word. The Style dialog box is displayed. Select All Styles 
from the List drop-down list. Select Heading 1 in the Styles list and click Apply. Repeat 
for all heading styles or their equivalent, up to Heading 4. The heading styles have now 
been created in the document.

3 Select Replace on Word’s Edit menu. The Replace dialog box is displayed.
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4 In the Find What box, type the text within the <ps...> tag. Do not include either the 
angle brackets or the number following the style name. For example, if the tag reads 
<ps "Head 1" 1>, type ps "Head 1" only, as illustrated below, and choose 
tw4winExternal from the Style drop-down list.

5 Click inside the Replace With box. Select Heading 1 from the Style drop-down list and 
click Replace All.

6 Word applies the Heading 1 style to all paragraphs containing the tag specified under 
Step 4. Repeat the same procedure for all <ps...> tags that you could identify. Make 
sure to apply different heading styles as required.

TIP
E

If you want to experiment with samples before using one of the procedures above for your own 
STF files, use the STF demo files shipped with WinAlign. They are located in the 
\Samples\WinAlign\STagRTF subfolder of WinAlign’s installation folder. The files 
Eng04Plain.rtf and Ger04Plain.rtf are plain STF files without Word heading styles. 
The files Eng04Structured.rtf and Ger04Structured.rtf are the same files after 
running the macro WinAlignPrepareSTF.
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Alignment Strategy

When creating a new WinAlign project of STF files, define your general settings in the General tab 
of the New WinAlign Project dialog box as follows:

C Choose Word Documents from the File Type drop-down list in the General tab of the New 
WinAlign Project dialog box. WinAlign aligns STF files in the same way as Word files.

C In the Alignment tab, define the weighting of the various tuning options to suit your 
alignment pairs.

C In the Structure Recognition tab, set the structure recognition depth and add the styles you 
have applied as described in Enabling Structure Recognition for STF Files on page 3-26. If you 
did not follow the procedure described in that section, set the structure recognition depth to 
Ignore.

Run the first alignment of a representative file pair and spot-check the result. If necessary, change 
the Alignment and Structure Recognition options to suit your alignment pairs. Repeat this procedure 
on the representative file pair until you are satisfied with the initial alignment result. For example, 
it may be better to set the structure recognition depth to Level 2 instead of Level 4 even if your 
documents have four heading levels.

After adjusting the Alignment and Structure Recognition options to your satisfaction, run the 
alignment of the whole project. After the alignment, check, edit and run re-alignments as necessary. 
Once you are satisfied with the project alignment, export the results.

The following workflow diagram summarizes the file preparation and alignment strategy for 
STF files.
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Figure 3.2 - Alignment Strategy for STF Files
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TRADOSTAG FILES

TRADOStag is an XML-based file format for representing both DTP and bilingual data. TRADOStag 
(TTX) provides a standard method for processing DTP file formats.

Use TagEditor to convert Word, RC files, Ventura tagged, PageMaker tagged, QuarkXPress tagged, 
InDesign and STF tagged text files to TRADOStag format. Simply open the tagged text file and save 
it as a TTX file. Alternatively you can use the S-Taggers to directly convert FrameMaker and Interleaf 
files to TRADOStag.

File Preparation

C Use the appropriate TRADOS Story Collector to set the story order in the QuarkXPress, 
InDesign and PageMaker files and export the files to QSC format (in the case of 
QuarkXPress), ISC format (in the case of InDesign), or TXT (for PageMaker) format. Use the 
native Export function in Ventura to obtain a tagged text file in TXT format.

C For FrameMaker or Interleaf files use the appropriate S-Tagger to generate the STF files. 

C Open the files in TagEditor, and save them as TTX files.

C You can then align the files using WinAlign.

FOR MORE INFORMATION
V

For more information on converting to TRADOStag, refer to the Translator’s Workbench User 
Guide.

Alignment Strategy

When creating a new WinAlign project of TTX files, define your general settings in the General tab 
of the New WinAlign Project dialog box as follows:

C Choose TRADOStag Documents from the File Type drop-down list in the General tab of the 
New WinAlign Project dialog box.

C In the Alignment tab, define the weighting of the various tuning options according to the 
specific document features of your alignment pairs, for example, formatting or numbers. If 
you have a term list, add it by checking the Use Term List option. Click Term List and browse to 
select the tab-delimited text file containing your term list.

C In the Structure Recognition tab, set the structure recognition depth and add the styles you 
have identified.
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C Run the first alignment of a representative file pair and spot-check the result. If necessary, 
change the Alignment and Structure Recognition options to suit your alignment pairs.

C Repeat this procedure on the representative file pair until you are satisfied with the initial 
alignment result. For example, it may be better to set the structure recognition depth to 
Level 2 instead of Level 4 even if your documents have four heading levels.

C After adjusting the Alignment and Structure Recognition options to your satisfaction, you are 
ready to run the alignment of the whole project. 

C After the alignment, check, edit and run re-alignments as necessary. Once you are satisfied 
with the project alignment, export the results.

RC FILE FORMATS

You can process RC files using two different methods:

C Open the files in TagEditor, save and align them as TTX files

C Running the prepare macro

The RC files are marked up using macros included with WinAlign. The default location for the 
WinAlign7.dot template is C:\Program Files\TRADOS\...\TT\Templates. 

When this template is attached in Word, you can run any one of the macros by selecting Macro and 
clicking, for example, WinAlignPrepareRC on the Tools menu.

The WinAlign7.dot file also includes macros for preparing Ventura, PageMaker and 
QuarkXPress tagged text files for alignment. However, TRADOS recommends converting these file 
formats to TRADOStag, and aligning the resulting TTX files. See also TRADOStag Files on page 3-
31.

File Preparation

To run the macro on your particular file format:

1 Save the files as tagged text in the originating environment.

2 Open the files in Word as text only and save them out as RTF.

3 Attach the WinAlign template (WinAlign7.dot).

4 Select Macro on Word’s Tools menu.
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5 Select the macro for your file format. For example, for RC files, use WinAlignPrepareRC.

6 Click Run.

7 The macro marks up tags in the file with the styles tw4winExternal and tw4winInternal. 

NOTE
D

The macro runs on one file at a time.

8 Repeat this procedure for all files. You are now ready to start the alignment.

Enabling Structure Recognition

In contrast to the file types described previously (Word, online help, HTML and SGML), tagged files 
do not contain styles such as Heading 1 or <H1> that can be used for structure recognition in 
WinAlign. As a result, WinAlign's structure recognition feature cannot be used on these files.

You can, however, enable the structure recognition for all other tagged file formats by following the 
same procedure as for STF files, see Manually Applying Word Heading Styles on page 3-27. The tags 
will look a little different for each format. 

NOTE
D

You can also use the T-Window for Resources to align Java PROPERTIES files.

MICROSOFT.NET RESOURCE FILES

The Microsoft .NET programming language uses resource files (*.resx) to store the text that appears 
on the user interface of a .NET application. Trados 7 contains a tag settings file called resx.ini which 
you can use to align *.resx files in WinAlign. 

To align *.resx files in WinAlign follow these steps: 

1 Open WinAlign and choose New Project. 

2 Give the project a name and set the source and target language as usual. 

3 Choose XML files as the file type. 

4 Choose Tag Settings to specify a tag settings file. 

5 Select RESX resource files (resx.ini) and set it as the default settings file. 

6 Proceed to the Files tab in WinAlign. 
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7 Click Add to add the source files. 

8 Browse to the folder where the *.resx files are located. 

9 Choose to show all file formats. 

10 Select the *.resx files and click Open. 

11 Add the target file in a similar manner. 

12 Apply any further settings and confirm with OK to close the Project Settings dialog 
box. 

13 Align the files. 

NOTE
D

*.resx files can be aligned by renaming the files as *.xml and using the DTD Settings file xsl.ini. 

WINDOWS BINARY FILES

Windows Binary files(*.exe,*.dll, *.ocx *.lng) can be opened directly in WinAlign.

MICROSOFT POWERPOINT FILES

Microsoft PowerPoint files can be opened directly in WinAlign.

Comments in PowerPoint files

By default, comments in a Microsoft PowerPoint document are excluded when aligning files. 

When aligning PowerPoint documents you might want to include comments. This can be done by 
editing the PowerPoint filter definition file that is installed with TRADOS. 

1 Locate the file PowerPoint_1_0_0_0.xml, by default located in C:\Program 

Files\TRADOS\xx\TT. 

2 Open this file in a Unicode-enabled text editor, such as Notepad on Windows 2000 or 
Windows XP, and search for the string 
<CommentProcessing>Default</CommentProcessing>. 

3 Change the value Default to On and save the file. 
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Comments in PowerPoint documents will now be included in alignment with WinAlign.

Notes Pages in PowerPoint files

By default, Notes pages in a PowerPoint presentation are included in the alignment of PowerPoint 
files. 

When aligning PowerPoint files you might want to exclude the Notes pages. This can be done by 
editing the PowerPoint Filter definition file that is installed with TRADOS 7. 

1 Locate the file PowerPoint_1_0_0_0.xml, which is found by default in C:\Program 
Files\TRADOS\xx\TT 

2 Open this file a Unicode-enabled text editor, such as Notepad on Windows 2000 or 
Windows XP, and search for the string 
<SlidesInPresentationOrder>Default</SlidesInPresentationOrder>

3 Set the value Default to NoNotes.

The Notes pages are excluded from alignment with WinAlign

MICROSOFT EXCEL FILES

Microsoft Excel files can be opened directly in WinAlign.

Comments in Excel files

By default, Comments in an Excel file are excluded in the alignment of Excel files. When aligning 
files you might want to include Comments. This can be done by editing the Excel Filter definition 
file that is installed with TRADOS. 

1 Locate the file Excel_2_0_0_0.xml, which is found by default in C:\Program 
Files\TRADOS\xx\TT 

2 Open this file in a Unicode-enabled text editor, such as Notepad on Windows 2000 or 
Windows XP, and search for the string: 
<CommentProcessing>Default</CommentProcessing>

3 Set the value Default to On. 

Comments in Excel file are now included in alignment with WinAlign. 
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